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The Gold Mining Business
|ﬁ GOLD MINING COSTS

Complete Cost vs Gold Price

== All-in sustaining cost

s Fully loaded all-in cost
= Gt Price ; 'S Less and less bang
[ = for the Exploration buck!
Endowment (Moz)® Gold Exploration Spending (Us$B)
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Cost control is paramount ELEMENT ANALYTICS"
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Barrick in the Gold Mining Business

- Reserve Ounces (Moz)
Market Cap
Company  (US$Bn) :
d 2015 2014 harmes
6 | Barrick 4 157 7.4
5 || Newmont 14 8.57
E 4 I Goldcorp 13.19 10.99
£ 3 I Newcrest 993 6.44
g 2 | Polyus 8.79 8.64
s 17 Agnico 7.93 5.45 A
0 Newmont Anglogold Ashanti 558 3.48 N
Barrick AnglogGOId Fields 3.25 2.3
Yamana 291 1.63
Eldorado 225 221 1.0 1.1 1.2 13 14

Reserve Grade (g/t)

{1} Sowurce: Company filings, See final slide #4.
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How Did Barrick Become #1 Again?

CANADA

2012
25 operating mines
~7.5 million ounces produced
AISC US$915
Reserves 104.1 million ounces

12 operating mines

~6.25 million ounces produced
AISC US$831

Reserves 93 million ounces

ELEMENT ANALYTICS®
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All In Sustaining Costs (AISC)

[T - Does not include
Direct Production Cost v v
Onsite Admin and Regulatory Costs v ¥ ¢ CapeX fOI’ new mine
" X v v .
Royalties and Production Taxes CO nstru Ctl on
Smelting, refining and transport v v
By-product Credits v 4 ¢ Debt repayment
Corporate General and Admin Costs x v
Reclamation and Remediation x v
Exploration (Sustaining) x v
Stripping and Mine Development x  d
(Sustaining)
Sustaining Capex x v

ELEMENT ANALYTICS®
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Barrick’s Goal — Gold Price Agnostic

“Our aspiration is to achieve all-in sustaining costs

below $700 per ounce by 2019.”
2013 2014 2015
Guidance 920-980 Guidance 830-860
Actual $915

The Law of Diminishing Returns

ELEMENT ANALYTICS®
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>

“It is crucial to the future of the company that

Barrick become a Data-Driven Decision-making
Organization”

Jim Gowans, Chief Operating Officer, 2014

@ osisoit. USERS CONFERENCE 2016 © Copyright 2016 OSIsoft, LLC 8



The Digitization of Barrick

Dynamic Mass-

Energy Balance _
Business

Enablement and

Sub $800 Simplification
AlISC

Best in Class

Production
Costing Water

Condition-Based Management
Maintenance (CBM)
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“Our aspiration is to achieve all-in sustaining
costs pbelow $700 per ounce by 2019.”

Network analysis Simulation

Advanced Analytics

Forecasting Nearal xetwerh Data Mining

— Machine Learning D ata Smence

Declswl tree An al Descnptwe Analysis

Setmmtm |ass| |cat|on ormary least sguares

CurrelatlnnPredmtw ¢ Analytics

Time series Optimization Modeling
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Pueblo Viejo Mine

 Barrick’'s newest mine

 Produces 800k ounces of
gold per year

« Most advanced PI site

« Doing very innovative work
with Pl on Energy and CBM

« Have a positive attitude
toward new ideas

ELEMENT ANALYTICS®
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Producing Analytics

Descriptive Analytics Predictive Analytics

Downtime in Limestone Operations

Lime Downtime Duration by Manth Unplanned Equipment Downtime Distribution

me Distribution by Type (Planned, Unplar Unplanned Downtime (Mean and Stdev)
ad Blrgiar

ELEMENT ANALYTICS®
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Demo: Descriptive
Analytics
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How we got to Descriptive
Analytics Quickly

ELEMENT ANALYTICS®
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Emerging Categories Create a lot of Noise

. Industrial Internet
Internet of Things .

Increasing
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Looking for Solutions That Make
; | | : fect]

ELEMENT ANALYTICS®
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Element Analytics Platform Architecture (an OSlsoft ConnectedApp)

Data Preparation -> Predictive Modeling -> Application
nnnection
Bieta TGk Acel B Predictive > Predictive Web Power BI

Models Services

Data Standardization o : PI
Engine Contextualization Engine > Integrator_}Prepped ET)\ata Subsets_)

Event Hub

Cloud

@,- OSlsoft Pl System
(Analytics) External Data Sources

(e.g., LIMS, EAM, CMMS, ERP)

-Iement Analytics Installed on Customer Tenant on Microsoft Azure

'((,.-.-DSIsoft Pl System

(Operational) (Additional Data Historians)
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Demo: Element Platform

ELEMENT ANALYTICS®
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Contextualization — Easily Surface Events, and Label them as Event Frames.
We Use All Assets of an Asset Template + All Historical Data to Surface Events

Niner A (©  ALcement Admin -
Events EUSELEE DS Y Run event pattern recognition
Unidentified
Event 62
Event label Label event Ignore event
Event 64 Setun emai ntfications
An/pv 10 times
Event 65
860 2
Event 66 B4p- ¥ 1]
2 [
820 &
.
Event 67 800
.
780
L]
Event 68 760
o .
740 .
Event 69 720 .
* (]
o .
700 geegtens_seteeete, se0etense®” st®ee [T
E t 70 680 L] Time
Fi25  O1AM  O02AM  O3AM O4AM O5AM OBAM O7AM O0BAM 0SAM  10AM  TAM
Event 71
860 »
Event 72 40| ¥ 2 ©
H .
820 §
.
Event 73 800
.
780
.
Event 74 760
o ]
740 .
Event 75 720 ™
« * L
L]
0 . q @ @ .
me
Event 76 -
0475 0430 0445 OSAM 0515 0530 0545 OBAM 0615 OE30 0645 O7AM  O7
Event 77
Event 78

_____ ENT ANALYTICS”
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Pl Integrator

J/ @@ Pl Integrator x\_\_\.
| « C' [ localhost:7777/Designer &=
ushing
Select Data > Modify View > Publish
=+ Add Column Y Edit Row Filters £Z Edit Value Mode Stime Edine
"o Qs Kt i | 2015-09-01 l ‘ 2015-12-01 |
crusher LocalTime POWER POWER_FLT ‘ RUN_HOURS TRIP_CODE
crusher #107462 2015-09-01 00:00:00 161.80 106.72 10086.39 null =
crusher #107462 '2015_09_01 00:01:00 41.80 63.84 10086.40 null
crusher #107462 2015-09-01 00:02:00 141.03 86.66 10086.42 null
crusher #107462 12015-09-01 00:03:00 180.92 143.72 10086.43 null
crusher #107462 :12015-09-01 00:04:00 102.15 151.71 10086.44 null
crusher #107462 :2015-09-01 00:05:00 172.03 166.77 10086.46 null
crusher #107462 12015-09-01 00:06:00 202.72 220.09 10086.47 null
crusher #107462 :12015-09-01 00:07:00 :191.98 191.98 10086.48 null
crusher #107462 2015-09-01 00:08:00 133.58 190.41 10086.50 null
crusher #107462 12015-09-01 00:09:00 163.68 194.39 10086.51 null
crusher #107462 2015-09-01 00:10:00 193.58 166.71 10086.52 null
crusher #107462 32015-09-01 00:11:00 14264 152.84 10086.54 null
crusher #107462 »2015-09-01 00:12:00 43.00 85.04 10086.55 null
crusher #107462 12015-09-01 00:13:00 41.96 46.57 10086.56 null
crusher #107462 2015-09-01 00:14:00 41.25 4432 10086.57 null
h HANT ALY :")I'\'I' N0 N4 A0-4E-00 AN B&E A2 Q0 4000C EO ol ¥
coomeNT ANALYTICST
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Getting Predictive Results

ELEMENT ANALYTICS®
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Every Minute Counts!
Now That We Can Measure It And See It, We Can Do Something About It

ldentifying the Opportunity How to Solve the Problem
« With PowerBI, we identified * Requirement:
downtime issues with the — need at least 1 week notification in
limestone crushing system. advance to predict potential faults
« Challenge:
« The biggest 3 systems on that — Scheduling more frequent
circuit are: maintenance doesn’t scale.
— Limestone crushers * Solution:
— Lubrication system — Need to catch faults before they
— Conveyor happen

— Need Data Science to create
predictive models

ELEMENT ANALYTICS®
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Approach to build a model to predict unplanned failures
in [imestone circuit a week in advance

Prepared
Data Generated Features Algorithms
(Pl + External Data)

Predictive Model
Streaming Predictive ReDOrts
Pl Data Web Service P

ELEMENT ANALYTICS®
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Identifying Features

* Dynamic Features

- Traditional tags that change based off the conditions of
the system it is monitoring

« Alarm Features

- Binary status/state tags that indicate on/off conditions
of the system it is monitoring

ELEMENT ANALYTICS®
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Dynamic Features

Crusher Lubrication System Conveyor
'
. Current Discharge Pressure o Head Temperature
*  Main Drive Coupling Zero Backup Pump Pressure «  Weight Scale
Speed Oil Res Temperature

. Power Used Conveyor Current

. Area Receiver Pressure

. Pulse Air Receiver
Pressure

. MPS Pressure

Oil Rtn Line Temperature
Primary Pump Pressure
Centrifugal Filter Pump
Cooling Fan

Pump

Std Dev. Min Max Mean

ELEMENT ANALYTICS®
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Alarm Features

Crusher

Blower Filter Warning
UPS Alarm

Dirty Filter Warning
Plugged Filter Warning
Screen Diverter Feed
Chute Level

Lubrication System

Oll filter Valves Closed
High Oil Temp Alarm
Low Oil Temp Alarm
Low Oil Level Alarm
Oil Filter Valve Open
Filter Plugged

Daily Counts

Conveyor

Conveyor RIP Detect
Conveyor Tail Speed
Conveyor Misalign
Conveyor Pullcord

ELEMENT ANALYTICS®
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Splitting the Data to Build the Model

Pl + RtDuet Data

1/1/2015 11/30/2018

Training Data Test Data

(also used for cross validation)

1/1/2015 9/10/2015 11/30/2015

ELEMENT ANALYTICS®
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Decision Trees

Automatically identify
ways to divide data.

Petal.Length
p < 0.001

=19

=1.9
Petal Width
p<0.001

=17 =>1.7
P'etaILength
p < 0.001
54E ::-48

Node 2 (n = Node 5 {n = éNodeB (n= Node? (n = 46)

1 1

0.8 0.8 0. 8 0.8

0.6 0.6 0.6 0.6

0.4 0.4 0.4 0.4

0.2 0.2 0.2 0.2
0 0 0 0
setosa setosa seftosa setosa

ELEMENT ANALYTICS®
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Support Vector Machines

SVM with linear kernel LinearSVvM (linear kernel)

-
......

Sepal width
Sepal width

Finds Non-linear |
separation in data sepalfength Sepal length

SVM with RBF kernel

r. ..-":l

SVM with polynomial (degree 3) kernel

=
]
§=
=
©
o
u
55

7 osisot. USERS CONFERENCE 2016

Sepal width

Sepal length Sepal length

ICS™
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How to Measure Predictive Model Performance

The Ecosystem of a
Predictive Mode

*  True Positive

*  True Negative
* False Positive
* False Negative

*  Precision

— TP/(TP+FP)
* Recall

— TP/(TP+FN)

ELEMENT ANALYTICS”
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Crusher Predictive Initial Results

Crusher System  precision

Predictive Results
Number of assets trained upon 1
7 7 Actual number of days that are predictive of 19
faults

Actual number of days that are predictive of 48

7
12
7

non-faults
Reca” Number of faults predicted by model 14
% predicted faults that actually occur 7 (50%)
7 % of predicted faults that are non-faults 7 (50%)
% of total faults that were predicted 7 (37%)

12
41

TP - Correctly predicted faults FP - Incorrectly predicted faults
TN - Correctly predicted non-faults FN - Actual fault, but not predicted

ELEMENT ANALYTICS®

@ osisoft. USERS CONFERENCE 2016 © Copyright 2016 OSlsoft, LLC 31



Lube System Predictive Initial Results

Lube System Precision
Predictive Results

8

8 Number of assets trained upon 1

Actual number of days that are predictive of 18
faults

10
11
Actual number of days that are predictive of 46
11 non-faults
Reca” Number of faults predicted by model 19
% predicted faults that actually occur 8 (42%)
g % of predicted faults that are non-faults 11 (58%)
10 % of total faults that were predicted 8 (44%)
35

TP - Correctly predicted faults FP - Incorrectly predicted faults
TN - Correctly predicted non-faults FN - Actual fault, but not predicted

ELEMENT ANALYTICS®
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Conveyor Predictive Initial Results

Conveyor System  precision
Predictive Results

11 15 ’ Number of assets trained upon 1
Actual number of days that are predictive of 33
26 faults

‘ 26 Actual number of days that are predictive of 28

non-faults
Reca” Number of faults predicted by model 41
13 7 % predicted faults that actually occur 23 (67%)
‘ % of predicted faults that are non-faults 17 (33%)
% of total faults that were predicted 26 (79%)

15 26

TP - Correctly predicted faults FP - Incorrectly predicted faults
TN - Correctly predicted non-faults FN - Actual fault, but not predicted

ELEMENT ANALYTICS®
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Recap

ELEMENT ANALYTICS®
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Recap: The Analytics Journey Requires the Right Data to Enable it

: : : Prescriptive
Getting valuable foresight requires Analytics
increasingly proactive, advanced o .

. . . Pred|ctlve + How can we make it
analytics, supported by the right kind ; happen? .
Analyﬂcs » Provides recommendations
of data. ] - for the best course of action
Dlagnostlc *+ What will happen? to achieve desired
. + Provides predictions that outcomes
AnalytICS lower maintenance costs,
.. L optimize efficiency, and
Descrlptlve : x‘gg‘:)’;:;‘d Why did it improve worker safety Prescri ptive
AnalytiCS - Provides insight and
visibility into what can be . - Data
+ What happened? improved where Predictive Data
BaSiC AnalytiCS + Provides info about

failures and other past
problems

Diagnostic Data
» Tag-by-tag querying

Descriptive
Today s Data Data

Connected to multiple systems
+ Site to site data variance
+ Varying naming conventions
* Inconsistent units of
measurement

Asset Framework Event Frames Sensor Audit Integrations/Connections

Analytics Maturity

ELEMENT ANALYTICS"
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Lessons Learned

* Involve the site team from the beginning

* Provide as much PI data as possible

* Provide detailed descriptions of your PI tags
* Provide any supporting data — RtDuet, Ivara

« Have a follow-up workshop to present and discuss
the results

ELEMENT ANALYTICS®
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Contact Information

lain Allen
lallen@barrick.com
Senior Manager, Mining IT
Barrick Gold

NS

. sssssih |B.BARRICK

Sameer Kalwani

sameer@elementanalytics.com
Co-Founder & VP of Product
Element Analytics

ELEMENT ANALYTICST
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Questions

Please wait for the
microphone before asking
your questions A

State your
name & company

Please don’t forget to...

Complete the Online Survey
for this session

ELEMENT ANALYTICS®
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AL

ot

Lt Bt 6
Sanke 159 15

By Merci Gracias
% Thank You
N BOHES

4 Talk to us about:
Predictive Analytics for Industry - http://bit.ly/1UfGnPt

A The Future of Industrial Big Data and Its Data Tech Stack - http://bit.ly/1mg2CsY
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Downtime Overview

Operations

Grinding Ops

Lime Boil

Lime Kilns

Lime Slaker
Limestone Crushing
Limestone Grinding
Neutralization Ops
Ore Crushing

Ore Grinding
Pebble Crushing

Month

April
August
December
February
January
July

June
March
May
November
October
September

Minutes Waiting for Trucks

9,543

Minutes Waiting for Stone

28,161 65

Downtimes w/o Comments

Downtime Duration by Source Site

RootCategoryType @ Electrical @Mechanical @Operations

Limestone Crushing

Lime Slaker

Lime Kilns

Limestone Grinding

Ore Crushing

Neutralization Ops

Ore Grinding

Grinding Ops

Lime Boil

Pebble Crushing
0K

1K 2K 3K

% Downtime (Planned, Unplanned, Constrained)

Unplanned

Planned

Constrained

Downtime Duration by Source Site (Planned vs. Unplanned)

RootCategorylsPlanned FALSE @TRUE

x -y
" . ] []
1K
- —
oK £ S & S S ) W\ e A N ) S
T L P LN e S L S
e O R & I & o o A N
[SXRT N C e CANI 5 N
(S VW e g W 0
X
\r\«@%\ o «®

Downtime Duration by Type (Planned, Unplanned, Constrained)

RootCategoryDisplayText ~@Constrained @Planned @Unplanned
1.0M

0.8M
0.6M
0.4M

0.2M

0.0M

Operations Mechanical Electrical




Downtime in Limestone Operations

Lime Downtime Duration by Month Unplanned Equipment Downtime Distribution
Lime Kiln 2 Lime Kiln 1

Lime Slaker

Operation  @Lime Boil @Lime Kilns @Lime Slaker @Limestone Crus... @Limestone Grind...

100K

§_N [] [
60K . - . . Unplanned
- - Limestone Crushing
40K Unplanned
20K
oK Unplanned
0 2 4 6 8 10 12
Lime Downtime Distribution by Type (Planned, Unplanned) Unplanned Downtime (Mean and Stdev)
RootCategoryDisplayText Planned @Unplanned RootCategoryDisplayText @Unplanned © Standard deviation of EFDurationHrs
100% 2.0
» 3
80% g 15
g
S
2
60% g 10
5
40% % ]
£ o5
2
20%
0.0 0
0% Lime Kiln 1 Lime Kiln 2 Lime Slaker Limestone Limestone
Lime Kilns Limestone Crushing Limestone Grinding Lime Slaker Lime Boil Crushing Grinding

U I\ \ U




Crusher Equipment CI’USher DOWﬂtIme

Blower Energy Consumption
Crusher
Fan Sensor @AIT PV @CURRENT POWER @POWER_FILT
400 . .
Flow Rate Indicator Crusher Daily Unplanned Downtime
RootCategoryDisplayText @Unplanned
. 9/26
Machine
200 9/27
Lime Boil /\_/\/—/\/\/\/J 42
Lime Kiln 1 ,\/\/v\/\/\/__/\ 9/28
Lime Kiln 2 7/21
Lime Slaker e B S 6/7
- E ST T T T ododaooddod
Limestone Crushi... e P 0 5 10 15 20 25
Limestone Grindi...
Downtime Type Top 10 Reasons for Crusher Downtime (Mean and Standard Deviation)
Constrained @ Average of EFDurationHrs @Standard deviation of EFDurationHrs
10
Planned
% Unplanned
5
0
Date Motor Crusher 6183-CVB-530 6183-CVB-562 Lube System Constrained 1-Other 6183-CVB-540 Instrumentation
11
1/10 Maintenance Logs
1/13 Date_Mont... 4 Reason Comment A
1/14 11 \Lime Kilns\Kiln 1 chequeo de valvula de vapor
117 1/10 \Limestone Grinding\Mill\6186-MIL-570 (Ball Mill) limpieza en la canaleta de los ciclones
12 1/10 \Lime Slaker sordadura de soporte del alimentador o screen, estaba roto
1/13 \Limestone Crushing\Conveyor\6183-CVB-540 6183-CVB-540 Fault
1720 1/13 \Lime Kilns\Kiln 2 Change filters in the Blowers o

1/21 1 \limea Slakan Canctrainad hanaa of Snring in the Seraan




Getting Ready for Analytics:
Moved Pl Tags into Consistent Asset Templates

Niner L (© A Element Admin ~

Sensor Name Patterns [ | 7700 of 27266 sensors mapped

crusher Edit  Duplicate  Delete

B s of 36 censors mapped

Number 8 CRU Number [ Any character [E22

mill

B =6 of g6 sensors mapped

Number B MIL Number [BE] | Any character (2225

valve Edit  Duplicate  Delete

B =75 of 1576 sensors mapped

Number B HV Number [I] | Any character 2225

valve

B 1541 o7 1841 sensors mapoed

Number B~ XV Number Any character B2

valve

P ccfc sensors mapped

Number B ZIC Number ] | Any character 228

We were able to get 7700 tags across 11 asset templates completed in 3 hours,
using the Element Analytics Platform LvTICS”
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Created Asset Hierarchies

Niner D ® Leementadmin
Asset Hierarchy Syne with AF -
DEFAULT HIERARCHY

Elemant Higrarchy 1 Area-based Setdefautt  Delete

OTHER HIERA]

Area ¥ Asset template
Area-based

Counter Equipment Hierarchy

Element Hierarchy 2 Collapse all

- Area - B183
= Assettemplate - Instrument
b Instrument 7107623

Equipment Area Hierarchy

~ Area - Canveying Fluor
'~ Asset template - Conveyor Belt
b Conveyor Beit 4106632
+ Conveyor Beit 4106630
» Conveyor Beit 4106711
» Conveyor Belt 1106764
+ Conveyor Bet #106349
+ Conveyor Seit #107038
¥ Conveyor Belt #107356
¥ Conveyor Belt 4107378
+ Conveyor Beit #107621
b Conveyor Beit 4107658
= Asset template - Conveyor Serew
¥ Conveyor Screw #106877
» Conveyor Screw #107083
b Conveyor Screw 7107184
+ Comveyor Screw #107226
b Conveyor Screw #107358
v Asset template - Distributor
* Distributor #107414
v Assettemplate - Fan
» Fan 7106704
~ Asset template - Feeder
¥ Feeder #106811
¥ Feeder #106887
b Feeder 4107362
b Feeder #107410
» Feeder 1107533
~ Asset template - Instrument
b Instrument #106677
b Instrument #106881
b Instrument 4106586
b Instrument #106508
» Instrument #106693
b Instrument 7106695
b Instrument #106696
b Instrument #106697
b Instrument 4106707
¥ Instrument #106709
*» Instrument #106710
» Instrument 7106716
b Instrument #106718
b Instrument #106724

ELEMENI ANALYTICS”
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Questions

Please wait for the
microphone before asking
your questions

State your
name & company

Please remember to...

Complete the Online Survey
for this session

=~ | DOWNlOad the Conference App for
— = OSlsoft Users Conference 2016

) [ App Store
* View the latest agenda and create your own

P Google Play

S HTML

* Meet and connect with other attendees

http://ddut.ch/osisoft
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